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• La copie des données de séquence de musique disponibles dans le commerce et/ou de fichiers audio 
numériques est strictement interdite sauf pour usage personnel.

• Les copyrights du logiciel et de ce mode d'emploi sont la propriété exclusive de Yamaha Corporation.
• Toute copie du logiciel ou de ce mode d'emploi en tout ou en partie, par quelque moyen que ce soit, est 

expressément interdite sans le consentement écrit du fabricant.
• Yamaha n'offre aucune garantie quant à l'usage du logiciel ou de la documentation et ne peut être tenu 

pour responsable des résultats de l'usage de ce mode d'emploi ou du logiciel.
• Les captures d'écran présentes dans ce mode d'emploi sont fournies à titre indicatif et peuvent être 

légèrement différentes de celles qui apparaissent sur votre ordinateur. 
• Cliquez sur le texte en rouge pour passer à la partie correspondante du manuel.
• L'OMS

 

®

 

 et  présentés dans ce mode d'emploi sont des marques de fabrique ou des marques 
déposées de Opcode Systems, Inc.

• Les noms des sociétés et des produits apparaissant dans ce mode d'emploi sont des marques de 
fabrique ou des marques déposées appartenant à leurs propriétaires respectifs.

 

© 2002 Yamaha Corporation. Tous droits réservés.

 

Ce mode d'emploi part du principe que vous êtes familiarisé à l'environnement Windows ou Macintosh. 
Si tel n'est pas le cas, veuillez vous reporter au mode d'emploi de votre logiciel Windows ou Mac OS 
avant d'utiliser le Voice Editor.

Pour toute information sur la configuration matérielle requise, les interconnexions entre les 
périphériques et l'installation du logiciel Voice Editor, reportez-vous au « Manuel d'installation » et au 
mode d'emploi de l'appareil MIDI correspondant.

Les captures d'écran présentées dans ce manuel proviennent principalement de Windows. Les 
différences avec la version Macintosh sont clairement indiquées et expliquées.

A l'attention des lecteurs
Veuillez noter qu'en fonction du système de PC utilisé, il est possible que les illustrations, les couleurs et les polices ne s'affichent pas correctement. Veuillez également noter que les numéros de page des images miniatures peuvent ne pas correspondre à ceux du document.
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Qu'est-ce que le Voice Editor ?

 

Le Voice Editor (Editeur de voix) est une application qui vous permet d'éditer les voix et les effets 
de votre synthétiseur via l'ordinateur. Grâce à l'interface graphique facile à comprendre, vous 
pouvez éditer quasiment tous les paramètres de voix du S90 depuis votre ordinateur — en 
utilisant la souris pour régler les boutons virtuels, les curseurs et les touches et en saisissant des 
valeurs à l'aide du clavier de l'ordinateur. En outre, vous pouvez sauvegarder sur l'ordinateur 
toutes les modifications apportées aux voix. Si vous avez sauvegardé les modifications 
apportées sur une carte mémoire (SmartMedia) installée sur l'ordinateur, vous pouvez insérer la 
carte mémoire dans votre synthétiseur et lire son contenu directement lorsque le type de fichier 
de chargement est paramétré sur « Voice Editor ».

Fenêtre Library
Sauvegarde du fichier 
Bibliothèque

Importation d'une voix

Fichier
Bibliothèque

Fenêtre Edit

Voix

Boîte de dialogue Element

Réglage des paramètres d'effet

Envoi / réception de blocs de données

Votre synthétiseur (S90)
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Démarrage du Voice Editor

 

Après avoir installé le Voice Editor et effectué les connexions requises, suivez les instructions ci-
dessous pour le lancer. 

 

Windows

 

n

 

Pour pouvoir utiliser le Voice Editor avec votre synthétiseur, vous devez installer le pilote MIDI USB (page 11).

 

• Démarrage du Voice Editor en tant qu'application autonome

 

1

 

Dans le menu [Start] (Démarrer), sélectionnez [Programs] (Programmes) 

 

→

 

 [YAMAHA 
OPT Tools] (Outils YAMAHA OPT) 

 

→

 

 [Voice Editor for S90] 

 

→

 

 [Voice Editor for S90].
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Cliquez sur le bouton [MIDI SETUP] (Configuration MIDI) appelé à l'étape 1 ci-dessus, puis 
configurez le port MIDI approprié.

 

• Démarrage du Voice Editor en tant que logiciel plug-in dans l'application hôte

 

Vous pouvez utiliser le Plug-in Board Editor en tant que logiciel plug-in dans toute application 
hôte (séquenceur, etc.) compatible avec l'Open Plug-in Technology (OPT - Technologie de 
plug-in ouvert). Pour plus de détails sur l'utilisation du logiciel plug-in, reportez-vous au mode 
d'emploi de l'application hôte.

 

A propos de l'Open Plug-in Technology

 

L'Open Plug-in Technology (OPT) est un nouveau format de logiciel qui vous permet de 
contrôler les appareils MIDI à partir d'un séquenceur de logiciels de musique. Vous pouvez par 
exemple démarrer et faire fonctionner différents éléments de votre système musical, tels que les 
éditeurs de carte plug-in et les éditeurs de commande de mixage, directement à partir d'un 
séquenceur compatible avec l'OPT, sans devoir les utiliser séparément. De plus, il n'est plus 
nécessaire de configurer des pilotes MIDI pour chaque application, ce qui simplifie votre 
système de production de musique et rend les opérations plus simples et plus sûres.

 

A propos des niveaux OPT

 

La compatibilité de l'application client avec l'OPT comprend trois niveaux différents, comme 
indiqué ci-dessous.

 

Niveau 1 

 

– L'OPT Panels offre un support de base pour l'ouverture et l'affichage des 
panneaux de commande OPT qui peuvent transmettre des données via les ports MIDI 
externes des clients. En général, ce niveau permet aux panneaux de commande de 
l'éditeur de matériel de base de fonctionner correctement.

 

Niveau 1 

 

– L'OPT Processors offre un support aux processeurs MIDI et à 
l'automatisation du panneau en temps réel. En général, ce niveau permet aux effets 
MIDI en temps réel et hors ligne (arpégiateurs, transposeurs, etc.) de fonctionner 
correctement et d'automatiser le fonctionnement d'OPT Panels. 

 

Niveau 3 

 

– L'OPT Views offre un support qui vous permet d'éditer les vues et les 
processeurs/panneaux MIDI qui exigent un accès direct aux structures de stockage du 
séquenceur client. En général, ce niveau permet de prendre en charge des vues 
d'édition MIDI évoluées (éditeurs de listes, accompagnement automatique, contrôleurs 
de données, etc.).
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Implémentation du niveau de l'OPT pour le Voice Editor

 

Ce tableau montre la compatibilité du Voice Editor avec l'OPT.

 

n

 

Il arrive que certaines opérations ne fonctionnent pas normalement lorsqu'il n'y a pas de fonction 
correspondante dans l'application client (séquenceur, etc.). Le niveau d'implémentation le plus haut 
de l'application client apparaît dans le logo OPT (qui s'affiche en même temps que les informations 
relatives à la version de l'application).

 

Macintosh

 

n

 

Si vous utilisez le Voice Editor sur un ordinateur Macintosh, sélectionnez « Chooser » (Sélecteur) dans le 
menu Apple et désactivez « AppleTalk ».

 

Ouvrez le fichier « YAMAHA Tools » (Outils Yamaha) et double-cliquez sur l'icône 
« VoiceEditorforS90 » dans le dossier « Voice Editor for S90 ».

 

Barre de menus

 

La barre de menus contient plusieurs fonctions/commandes d'édition et de configuration. 
Cliquez sur le nom de menu désiré pour ouvrir le menu déroulant correspondant et sélectionnez 
la fonction/commande que vous souhaitez utiliser. Les fonctions/commandes non disponibles 
apparaissent en grisé.

 

n

 

Les menus les plus fréquemment utilisés dans la barre de menus sont également disponibles sous la 
forme de boutons dans la barre d'outils du Voice Editor.

 

File (Fichier)

 

New (Nouveau)

 

Permet de créer et d'ouvrir un nouveau fichier Bibliothèque.

 

Open Library... (Ouvrir bibliothèque...) (Open...)

 

Cette commande est identique à celle du bouton « Open » (Ouvrir) de la barre d'outils (page 9).

 

Save Library (Enregistrer la bibliothèque) (Save)

 

Cette commande est identique à celle du bouton « Save » (Enregistrer) de la barre d'outils (page 10).

 

Niveaux de l'OPT de l'application client
Opération du Voice Editor

Support des opérations Limites des opérations

 

VIEWS (Niveau 3) Oui Aucune

PROCESSORS (Niveau 2) Oui Aucune

PANELS (Niveau 1) Oui Réception en bloc

Windows Macintosh
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Save Library As... (Enregistrer bibliothèque sous...) (Save As...)

 

Permet d'enregistrer le fichier Bibliothèque sous un nom différent ou nouveau.

 

Close (Fermer) (Macintosh uniquement)

 

Permet de fermer la fenêtre. Cette fonction est identique à celle de la case « Close » dans la 
barre de titre.

 

Exit (Quitter) (Quit)

 

Permet de sortir du Voice Editor. Ce menu n'est disponible que lorsque le Voice Editor est utilisé 
en tant que plug-in de l'application hôte. 

 

Edit (Edition)

 

Copy (Copier)

 

Copie la voix sélectionnée dans le presse-papiers. Si rien n'est sélectionné, cette commande 
apparaît en grisé.

 

Paste (Coller)

 

Copie la voix présente dans le presse-papiers vers le Voice Editor.

 

Edit

 

Cette commande est identique à celle du bouton « Edit Window » (Fenêtre Edit) de la barre 
d'outils (page 14).

 

Library (Bibliothèque)

 

Cette commande est identique à celle du bouton « Library Window » (Fenêtre Library) de la 
barre d'outils (page 16).

 

Store... (Stocker...)

 

Cette commande est identique à celle du bouton « Store » de la barre d'outils (page 28).

 

Import... (Importer)

 

Cette commande est identique à celle du bouton « Import » de la barre d'outils (page 14).

 

Compare (Comparer)

 

Cette commande est identique à celle du bouton « Compare » de la barre d'outils (page 29).

Windows Macintosh
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Setup (Configuration) (Windows) / MIDI 

 

(Macintosh)

 

Setup... (Editor Setup...) (Configuration de l'éditeur...)

 

Cette commande est identique à celle du bouton « Editor Setup » de la barre d'outils (page 11). 

 

Transmit Bulk... (Envoyer en bloc) (Transmit...)

 

Cette commande est identique à celle du bouton « Transmit Bulk » de la barre d'outils (page 12). 

 

Receive Bulk... (Recevoir en bloc) (Receive...)

 

Cette commande est identique à celle du bouton « Receive Bulk » de la barre d'outils (page 13). 

 

Monitor (Contrôler)

 

Cette commande est identique à celle du bouton « Monitor » de la barre d'outils (page 14).

 

OMS Port Setup... (Configuration du port OMS...) (Macintosh 
uniquement)

 

Ouvre la fenêtre OMS Port Setup du Voice Editor. Reportez-vous à la section « Configuration des 
ports OMS » (page 32) pour plus de détails.

 

OMS MIDI Setup... (Configuration MIDI de l'OMS...) (Macintosh 
uniquement)

 

Ouvre la fenêtre OMS MIDI Setup. Reportez-vous à la documentation fournie avec l'OMS pour 
plus de détails.

 

OMS Studio Setup... (Configuration du studio OMS...) (Macintosh 
uniquement)

 

Ouvre la fenêtre OMS Studio Setup. Reportez-vous à la documentation fournie avec l'OMS pour 
plus de détails.

Windows Macintosh
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Fenêtre Library

 

Lorsque vous lancez le Voice Editor, vous voyez d'abord apparaître la fenêtre Library, qui est 
constituée d'onglets représentant chacun une mémoire donnée du bloc du générateur de sons. 
Chaque onglet reprend la liste des noms, des numéros et des catégories de voix de la mémoire 
sélectionnée. Lorsque vous double-cliquez sur le nom d'une voix dans la fenêtre Library, la 
fenêtre Edit de cette voix s'ouvre, ce qui vous permet d'éditer la voix.

 

n

 

Vous pouvez sauvegarder vos réglages en tant que fichier Bibliothèque (*.W4E).

1

 

Barre d'outils

 

Cette zone contient les boutons permettant de commander le Voice Editor (page 9).

2

 

Onglets

 

Cliquez sur l'un de ces onglets pour afficher la liste des voix de la banque de voix 
correspondante.

3

 

Liste des voix

 

Cette zone affiche toutes les voix contenues dans la mémoire sélectionnée sous la forme 
d'une liste déroulante. Vous y trouverez le nom, le numéro et la catégorie de chaque voix. 
Pour réarranger les voix, il vous suffit de faire glisser leurs numéros jusqu'à un nouvel 
emplacement et de les y déposer. Windows vous permet par ailleurs de renommer une voix. 
Pour ce faire, sélectionnez le nom de la voix en question, puis cliquez de nouveau dessus et 
saisissez un nouveau nom. Sur un Macintosh, vous devez cliquer sur le nom de la voix tout en 
maintenant la touche [Control] enfoncée, puis choisir « Edit Voice Name » (Editer le nom de la 
voix) dans le menu déroulant et taper le nouveau nom dans la boîte de dialogue.

 

n

 

Pour sélectionner un bloc de voix en continu, cliquez sur le numéro de la première voix, maintenez la 
touche [Shift] enfoncée et cliquez sur le numéro de la dernière.

 

n

 

Les noms de voix peuvent comporter jusqu'à 10 caractères.

1

2

3

4
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Barre de fractionnement (Windows uniquement)

 

Si vous positionnez le pointeur de la souris sur la ligne (barre de fractionnement) qui sépare 
la section Track Parameter (Paramètres de piste) de la section Block (Bloc), le pointeur se 
transforme en outil de fractionnement. Servez-vous de cet outil pour faire glisser la barre de 
fractionnement et modifier la largeur des deux sections.

 

n

 

Vous pouvez modifier la taille de n'importe quelle fenêtre en plaçant le pointeur de la souris sur l'un 
des bords (supérieur, inférieur, gauche ou droit) et en faisant glisser celui-ci jusqu'à ce que la fenêtre 
atteigne les dimensions souhaitées.

 

Affichage des noms de voix uniquement (Windows uniquement)

 

Vous pouvez vous contenter d'afficher les noms de voix de la mémoire sans que leur numéro 
et leur catégorie n'apparaissent. Pour ce faire, cliquez avec le bouton droit de la souris à 
n'importe quel endroit de la liste de voix et sélectionnez « List » (Liste). Cela peut s'avérer 
utile pour sélectionner des voix rapidement, puisque la liste déroulante s'en trouve ainsi 
raccourcie.

 

n

 

Pour revenir à l'affichage de la liste complète des noms, numéros et catégories de voix, cliquez avec 
le bouton droit de la souris sur n'importe quelle partie de la liste et sélectionnez « Details » (Détails).
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Barre d'outils de la fenêtre Library

1

 

Bouton « Open »

 

Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Open » et sélectionner le fichier 
Bibliothèque à ouvrir.

 

Boîte de dialogue « Open »
Sélectionnez le fichier Bibliothèque de votre choix (extension .W4E) et cliquez sur [Open]. Le 
contenu du fichier sélectionné apparaît dans la fenêtre Library. 

n Si vous utilisez un ordinateur Macintosh, la boîte de dialogue « Open » traditionnelle s'affiche. 

1 Look in: (Regarder dans) ............. Cliquez sur cette zone et sélectionnez le dossier 
contenant les fichiers Voice Editor.

2 Zone de liste.................................. Affiche le contenu du dossier actuellement 
sélectionné.

3 File name: (Nom de fichier).......... Affiche le nom des fichiers sélectionnés dans la liste.
4 Files of type: (Type de fichier) ..... Cliquez sur cette case pour sélectionner le type de 

fichier.
5 Bouton [Open] .............................. Cliquez sur ce bouton pour ouvrir le fichier sélectionné 

dans la liste.
6 Bouton [Cancel] (Annuler)........... Cliquez sur ce bouton pour annuler l'opération.

1 2 3 4 5 6 7 8

1

2

3

4

5

6
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2 Bouton « Save » (Enregistrer)
Cliquez sur ce bouton pour enregistrer le fichier Bibliothèque existant contenant vos 
nouveaux réglages. Si vous travaillez sur un nouveau fichier, ce bouton ouvre la boîte de 
dialogue « Save As » dans laquelle vous pouvez nommer et enregistrer vos réglages dans un 
nouveau fichier Bibliothèque (*.W4E).

n Lorsque vous sauvegardez un nouveau fichier Bibliothèque (*.W4E), un fichier portant l'extension 
« .W5E » est automatiquement créé. Celui-ci est nécessaire pour charger le fichier Bibliothèque sur le 
synthétiseur à partir d'une carte mémoire. 

n Si vous sauvegardez un fichier sur un ordinateur Macintosh, l'extension « .W4E » n'est pas ajoutée 
automatiquement. Avant de charger ces fichiers sur votre synthétiseur, vous devez ajouter manuellement 
l'extension « .W4E » aux noms de fichier.

Boîte de dialogue « Save As »
n Les noms des fichiers Bibliothèque peuvent comporter 8 caractères maximum, plus une extension de 

3 caractères. 

n Si vous utilisez un Macintosh, la boîte de dialogue « Save As » traditionnelle s'affiche.

1 Save in: (Enregistrer dans) .......... Cliquez sur cette case pour choisir le dossier dans 
lequel vous souhaitez enregistrer le fichier 
Bibliothèque.

2 Zone de liste.................................. Affiche le contenu du dossier dans lequel vous 
souhaitez enregistrer le fichier.

3 File name:...................................... Précisez le nom du fichier Bibliothèque à sauvegarder.
4 Save as type: 

(Type de fichier à enregistrer) ..... Cliquez sur cette case pour sélectionner le type de 
fichier.

5 Bouton [Save] ............................... Cliquez sur ce bouton pour enregistrer le fichier 
Bibliothèque sous le nom spécifié dans la zone « File 
name ».

6 Bouton [Cancel]............................ Cliquez sur ce bouton pour quitter la boîte de dialogue 
sans enregistrer le fichier.

1

2

3

4

5

6
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3 Bouton « Editor Setup »
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Editor Setup » et effectuer les 
réglages du port de sortie MIDI.

Boîte de dialogue « Editor Setup »
C'est dans cette boîte de dialogue que vous devez configurer le Voice Editor de manière à 
pouvoir recevoir/transmettre des données de voix vers/depuis votre synthétiseur. Cliquez sur 
le bouton [OK] pour appliquer les réglages et quitter la boîte de dialogue et sur [Cancel] 
pour quitter la boîte de dialogue sans appliquer les réglages.

1 MIDI In Port: (Port MIDI In) ......................Cliquez sur cette case et sélectionnez le port MIDI 
In. Vous pouvez utiliser le Voice Editor pour 
recevoir des données envoyées par l'appareil 
connecté à ce port. 

2 MIDI Out Port: (Port MIDI Out) ................Cliquez sur cette case et sélectionnez le port MIDI 
Out. Vous pouvez utiliser le Voice Editor pour 
contrôler et éditer l'appareil connecté à ce port. 

n Si vous utilisez un Macintosh, le réglage du port MIDI Out se fait dans la fenêtre OMS Port Setup. 
Pour plus de détails, reportez-vous à la section « Réglages OMS » (page 31).

3 MIDI Ch: (Canal MIDI) ..............................Cliquez sur cette case pour sélectionner le canal 
MIDI Out. Cette fonction est utilisée lorsque le son 
est contrôlé à l'aide du clavier apparaissant à 
l'écran dans les fenêtres Edit.

4 Device No.: (N˚ de l'appareil) ..................Cliquez sur cette case pour sélectionner le 
numéro de l'appareil MIDI de votre synthétiseur. 

5 Dump Interval: (Intervalle de vidage) ....Cliquez sur cette case pour déterminer l'intervalle 
entre les vidages MIDI successifs.

n Si l'intervalle défini est trop court, des erreurs peuvent surgir lors de la transmission de données 
MIDI.

2

1

3

4

5

3

4

5

Windows Macintosh
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4 Bouton « Transmit »
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Transmit » qui vous permet de 
transférer tous les réglages à votre synthétiseur.

Boîte de dialogue « Transmit »
Vous pouvez envoyer les données de voix en bloc à votre synthétiseur. Il vous suffit de 
cliquer sur le bouton [Start] (Démarrer) pour commencer la transmission des données. La 
barre de progression vous indique le volume de données déjà transmis. Pour terminer, 
cliquez sur le bouton [Close] (Fermer) pour quitter la boîte de dialogue.

1 Transmit Type (Type d'envoi) ....... Détermine les données de voix à envoyer. 
User Normal................Toutes les voix utilisateur normales
User Drum...................Toutes les voix de batterie utilisateur
User Normal + Drum...Toutes les voix utilisateur
Plug-in 1......................Toutes les voix plug-in 1
Plug-in 2......................Toutes les voix plug-in 2
Plug-in 3......................Toutes les voix plug-in 3
Plug-in 1+2+3 .............Toutes les voix plug-in
All ................................Toutes les voix (normales, batterie et plug-in)

2 Barre de progression ................... Vous indique le volume de données déjà transmis.
3 Bouton [Start] ............................... Cliquez dessus pour transmettre les données.
4 Bouton [Close].............................. Cliquez sur ce bouton pour fermer cette boîte de 

dialogue.

n Le numéro de l'appareil MIDI doit être paramétré de manière à permettre l'envoi de blocs de données. 
Pour plus de détails, reportez-vous à la page 11.

1

2

3

4
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5 Bouton « Receive » (Recevoir)
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Receive » et recevoir ainsi tous les 
réglages de votre synthétiseur.

Boîte de dialogue « Receive »
Les données de voix peuvent être reçues en bloc depuis votre synthétiseur. Sélectionnez les 
blocs de données de voix que vous souhaitez recevoir, puis cliquez sur le bouton [Start]. La 
barre de progression indique le volume de données déjà reçu. Pour terminer, cliquez sur le 
bouton [Close] pour quitter la boîte de dialogue.

1 « Receive Type » (Type de réception) ...Cliquez sur ce bouton pour sélectionner les 
données de voix (internes/externes/toutes) à 
recevoir.

User Normal.................. Toutes les voix utilisateur normales
User Drum..................... Toutes les voix de batterie utilisateur
User Normal + Drum..... Toutes les voix utilisateur
Plug-in 1........................ Toutes les voix plug-in 1
Plug-in 2........................ Toutes les voix plug-in 2
Plug-in 3........................ Toutes les voix plug-in 3
Plug-in 1+2+3 ............... Toutes les voix plug-in
All .................................. Toutes les voix (normales, batterie et plug-in)

2 Barre de progression .............................Indique le volume de données déjà reçu.
3 Bouton [Start] .........................................Cliquez sur ce bouton pour recevoir les 

données.
4 Bouton [Close]........................................Cliquez sur ce bouton pour fermer la boîte de 

dialogue.

n Le numéro de l'appareil MIDI doit être paramétré correctement pour pouvoir recevoir des blocs de 
données. Pour plus de détails, reportez-vous à la page 11.

1

2

3

4



14

6 Bouton « Edit Window »
Cliquez sur ce bouton pour ouvrir la fenêtre Edit (courante) correspondant à la voix 
sélectionnée dans la liste. Pour plus de détails, reportez-vous à la page 15.

7 Bouton « Monitor »
Lorsque vous cliquez sur ce bouton, les données de voix sont envoyées en bloc à votre 
synthétiseur pour contrôle chaque fois que vous sélectionnez une voix. Cliquez de nouveau 
dessus pour désactiver cette fonction.

n Pour contrôler la voix, vous devez jouer sur le clavier du synthétiseur ou sur le clavier connecté à votre 
synthétiseur.

8 Bouton « Import »
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Import » et importer des voix 
provenant d'un fichier Bibliothèque existant. Vous pouvez utiliser la fonction glisser-déposer 
pour déplacer les voix en question dans la fenêtre Library.

Boîte de dialogue « Import »
n Il est possible d'ouvrir plusieurs boîtes de dialogue en même temps.

1 File name:..................Indique le nom du fichier Bibliothèque à partir duquel vous allez 
importer des données de voix.

2 Bouton [Open File] ... Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Open File » et 
sélectionner le fichier Bibliothèque à ouvrir.

3 Memory: (Mémoire) ..Cliquez sur ce bouton pour choisir la mémoire à partir de laquelle 
vous importerez les données de voix.

4 Liste de voix ..............Cette zone affiche toutes les voix contenues dans la mémoire 
sélectionnée sous la forme d'une liste déroulante, par numéro de 
voix. Vous pouvez y sélectionner une voix et l'importer directement 
dans la liste de voix de la fenêtre Library à l'aide de la fonction 
glisser-déposer. (Vous pouvez également importer plusieurs voix 
en même temps de cette façon.) Dans Windows, vous pouvez par 
ailleurs copier une voix. Pour ce faire, sélectionnez-la, puis 
appuyez sur les touches [Ctrl]+[C] du clavier de l'ordinateur. 
Basculez ensuite vers la fenêtre Library et appuyez sur 
[CTRL]+[V] à l'endroit où vous voulez la coller (importer). 

1

2

3
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n Pour sélectionner un bloc de voix, cliquez sur le numéro de la première voix, maintenez la touche 
[Shift] enfoncée et cliquez sur la dernière.

n Une voix normale ne peut être importée dans une voix de batterie ou une voix plug-in. De même, 
une voix de batterie ne peut être importée dans une voix normale ou plug-in. 

5 Monitor ......................Si vous cochez cette case, les blocs de données de chacune des 
voix sélectionnées sur la liste seront transférées vers votre 
synthétiseur S03 pour y être contrôlées. Pour contrôler la voix, 
utilisez le clavier de votre synthétiseur.

n Le contrôle sur écran n'est possible que si le port MIDI Out et les autres paramètres de configuration 
de l'éditeur sont correctement définis. Pour plus de détails, reportez-vous à la  page 11.

6 Bouton [Close]..........Cliquez sur ce bouton pour fermer la boîte de dialogue Import.

Fenêtre Edit
Le Voice Editor vous permet d'éditer trois types de voix : les voix normales, les voix de batterie et 
les voix plug-in. Dans la fenêtre Library, cliquez sur l'onglet contenant la voix normale/de batterie/
plug-in que vous souhaitez éditer. Double-cliquez ensuite sur la voix (ou sélectionnez-la et 
cliquez sur le bouton « Edit Window ») pour ouvrir la fenêtre Edit.

• Les réglages effectués dans la fenêtre Edit sont transférés en temps réel depuis votre 
ordinateur vers le synthétiseur via MIDI. 

• Les réglages de la fenêtre Edit peuvent être stockés dans un fichier Bibliothèque. 

• Pour plus de détails sur les différents paramètres, reportez-vous au mode d'emploi du S90 
et à la liste de données.

Fenêtre Voice Edit (Edition de 
voix)
Lorsque vous éditez une voix, l'écran suivant apparaît :

Bouton Editor Setup
Bouton Library Window
Bouton Store

Bouton Compare 4 5 62
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1 Barre d'outils
Celle-ci contient des boutons permettant d'exécuter différentes fonctions de base dans le 
programme. Les quatre boutons suivants sont disponibles : 

• Bouton Editor Setup ........................................ Voir page 11.
• Bouton Library Window (Fenêtre Library) ....... Cliquez sur ce bouton pour faire réapparaître la fenêtre 

Library. 
• Bouton Store ................................................... Cliquez sur ce bouton pour ouvrir la boîte de dialogue 

« Store » dans laquelle vous pouvez attribuer un nom à 
votre voix après l'avoir éditée et sélectionner l'endroit où 
la stocker.

• Bouton Compare............................................. Lorsque vous cliquez sur ce bouton, les blocs de 
données de la voix d'origine (avant édition) sont envoyés 
à l'instrument connecté. Cliquez de nouveau dessus pour 
envoyer les blocs de données relatifs à la voix éditée. Ce 
bouton permet alors d'effectuer des comparaisons A/B 
entre la voix d'origine et la voix éditée.

2 Panneau VOICE
Ce panneau affiche le nom et la catégorie/sous-catégorie instrumentale de la voix. Vous avez 
aussi la possibilité de renommer la voix éditée et de changer sa catégorie instrumentale 
depuis le menu déroulant « Voice Category » (Catégorie de voix).

n Les noms de voix peuvent comporter jusqu'à 10 caractères.

3 Panneau QUICK EDIT (Edition rapide)
Ce panneau vous permet de configurer les paramètres Quick Edit. 

n Les paramètres à régler différent en fonction de la voix sélectionnée (normale, batterie ou plug-in). Les 
paramètres pour lesquels des boutons apparaissent dans la fenêtre peuvent être édités. 

Utilisation des boutons de paramètres
Vous pouvez modifier le fonctionnement des boutons de paramètres. Pour cela, cliquez avec 
le bouton droit de la souris sur l'un des boutons et sélectionnez « Rotate » (Pivoter) ou « Up/
down or left/right » (Haut/bas ou gauche/droite).
Lorsque vous sélectionnez « Rotate », vous pouvez modifier les valeurs des paramètres (des 
« boutons » du panneau) par une rotation de la souris.
Lorsque vous sélectionnez « Up/down or left/right », vous pouvez modifier les valeurs des 
paramètres (des « boutons » du panneau) en déplaçant la souris verticalement ou 
horizontalement.

n Le réglage effectué ici affecte tous les boutons. 
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4 Réglages PITCH BEND (Variation de ton)
Utilisez le bouton « LOWER (Inférieur) » pour déterminer le point le plus bas de la plage de la 
molette de variation de ton et le bouton « UPPER (Supérieur) » pour définir le point le plus haut.

5 Bloc PORTAMENTO
Utilisez le sélecteur pour activer/désactiver la fonction portamento et le bouton « TIME » 
(Temps) pour spécifier la durée de portamento. Cliquez sur la zone de texte et sélectionnez le 
mode portamento. Le bloc « PORTAMENTO » n'est pas disponible pour les voix de batterie.

6 Bloc ARPEGGIO
Utilisez le sélecteur pour activer/désactiver les arpèges et le bouton « TEMPO » pour 
spécifier la vitesse de l'arpégiateur. Cliquez sur la zone de texte située sous le sélecteur pour 
sélectionner le mode arpège.
Cliquez sur la zone de texte située à gauche du sélecteur pour sélectionner le type 
d'arpèges. Vous trouverez les paramètres spécifiques aux arpèges dans la boîte de dialogue 
« ARPEGGIO » qui s'ouvre lorsque vous cliquez sur le bouton [DETAIL].

7 Bouton [CTRL SET/COM LFO]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « CONTROLLER SET /COMMON 
LFO » (Jeu de commandes/OBF courant). Dans le panneau supérieur, vous pouvez définir les 
paramètres de tous les contrôleurs tels que les molettes de modulation et de variation de ton. 
Le panneau inférieur vous permet de spécifier les paramètres de l'OBF courant.
Le panneau « COMMON LFO » n'est disponible que pour les voix normales.

Boîte de dialogue « CONTROLLER SET/COMMON LFO »

Panneau CONTROLLER SET
Vous pouvez affecter les contrôleurs de votre synthétiseur (par exemple, la molette de 
modulation ou la modification ultérieure du clavier) à divers paramètres de manière à pouvoir 
modifier ces derniers en temps réel. Par exemple, vous pouvez assigner la molette de 
modulation au paramètre de résonance du filtre lorsque la voix normale est sélectionnée. Au 
total, vous avez la possibilité d'affecter six contrôleurs.

1 SOURCE ....................................... Sélectionnez l'un des contrôleurs suivants : « FS » 
(commande au pied), « FC1 » (contrôleur au pied 1), 
« FC2 » (contrôleur au pied 2), « BC » (commande du 
souffle), « AT » (modification ultérieure), « PB » 
(molette de variation de ton), « MW » (molette de 
modulation), « AS1/2 » (Assignable 1/2).

2 Réglages DEPTH (Profondeur)... Détermine la mesure dans laquelle le contrôleur 
sélectionné affecte le paramètre qui lui est assigné.

1
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3 Réglages DESTINATION ............. Cliquez sur la zone de texte pour sélectionner le 
paramètre que vous souhaitez contrôler.

4 Sélecteurs ELEMENT .................. Cliquez sur ces sélecteurs pour activer/désactiver les 
éléments qui seront touchés par l'affectation des 
contrôleurs.

Panneau COMMON LFO (voix normale uniquement)
5 Réglage LFO WAVE ..................... Cliquez sur la zone de texte pour sélectionner la forme

(Onde d'OBF) d'onde de l'OBF.
6 Réglage LFO SPEED ................... Cliquez sur la zone de texte pour sélectionner la

(Vitesse de l'OBF) vitesse de l'OBF.
7 Réglage LFO PHASE ................... Cliquez sur la zone de texte pour sélectionner la phase

(Phase de l'OBF) de l'OBF.
8 Réglage [LFO KEY ON RESET] ....... Cliquez sur la zone texte pour sélectionner la méthode

(Réinitialisation de l'OBF) de redémarrage de l'OBF lorsqu'une note est jouée.
9 Réglage TEMPO SYNC ................ Cliquez sur la zone de texte pour activer/désactiver

(Synchronisation du tempo) TEMPO SYNC. 
) Réglage TEMPO SPEED .............. Cliquez sur la zone de texte pour déterminer la manière

(Vitesse du tempo) dont l'OBF est synchronisé avec l'arpège ou le 
séquenceur.

! Réglage DEPTH (Profondeur)..... Détermine la mesure dans laquelle le contrôleur 
sélectionné affecte le paramètre qui lui est assigné.

@ Réglages DESTINATION ............. Cliquez sur la zone de texte pour sélectionner le 
paramètre que vous souhaitez contrôler.

# Sélecteurs ELEMENT .................. Cliquez sur ces sélecteurs pour activer/désactiver les 
éléments qui seront touchés par l'affectation des 
contrôleurs.

$ Graphique de l'éditeur ................ Cliquez et faites glisser les « poignées » (repères 
carrés) pour déterminer le comportement de l'OBF 
courant en fonction du temps. La première poignée (à 
l'extrême gauche) commande le paramètre « LFO 
Delay Time » (Temps de retard de l'OBF), la deuxième 
le paramètre « LFO Fade In Time » (Temps d'ouverture 
par fondu sonore de l'OBF), la troisième le paramètre 
« LFO Control Time » (Durée de contrôle de l'OBF) et la 
dernière (à l'extrême droite) le paramètre « LFO Fade 
Out Time » (Temps de fermeture par fondu sonore de 
l'OBF). Faites glisser les poignées horizontalement 
pour régler les temps de transition.

% Bouton USER LFO....................... Cliquez sur ce bouton pour ouvrir la boîte de dialogue
(OBF utilisateur) USER LFO. 

Panneau User LFO (voix normale uniquement)

1 TOTAL STEP (Total des étapes) ... Détermine le nombre d'étapes de l'onde de l'OBF en 
cours d'édition, avec un maximum de seize.

1
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2 SLOPE (Pente) ............Détermine les caractéristiques de pente ou de rampe de l'onde 
de l'OBF.

• OFF .....................Pas de pente ; l'OBF atteint directement le niveau de chaque étape.
• UP .......................L'OBF passe à l'étape suivante lorsque la valeur de cette étape est 

supérieure. Pas de pente pour les étapes inférieures.
• DOWN.................L'OBF passe à l'étape suivante lorsque la valeur de cette étape est 

inférieure. Pas de pente pour les étapes supérieures.
• UP & DOWN........L'OBF passe au niveau supérieur ou inférieur pour atteindre le niveau 

de chaque étape.

3 TEMPLATE (Modèle) ...Vous pouvez sélectionner un modèle préprogrammé d'onde 
d'OBF. Le graphique de l'onde du modèle sélectionné apparaît 
dans la boîte de dialogue.

• random................Définit des valeurs d'étapes au hasard, en créant à chaque fois une 
onde d'OBF aléatoire différente.

• all0 ......................Les valeurs de toutes les étapes sont paramétrées sur 0.
• all64 ....................Les valeurs de toutes les étapes sont paramétrées sur 64.
• all127 ..................Les valeurs de toutes les étapes sont paramétrées sur 127.
• saw up ................Crée une onde en dent de scie vers le haut. 
• saw down............Crée une onde en dent de scie vers le bas. 
• even step ............Les valeurs de toutes les étapes paires sont paramétrées sur 127 et les 

valeurs des étapes impaires sur 0.
• odd step..............Les valeurs de toutes les étapes impaires sont paramétrées sur 127 et 

les valeurs des étapes paires sur 0.

4 Graphique de l'onde ...Cliquez sur la zone de texte pour sélectionner la méthode de 
réinitialisation de l'OBF lorsqu'une note est jouée.

5 RESET (Réinitialiser) ...Les valeurs de toutes les étapes sont réinitialisées sur 0. 
6 VALUE (Valeur)............Editez la valeur de chaque étape en vous servant du bouton 

correspondant.

CONTROLLER (voix plug-in uniquement)
Celui-ci détermine la profondeur de la hauteur de ton, de la coupure, de la modulation de 
hauteur de ton, de la modulation de coupure et de la modulation d'amplitude. 

8 Section ELEMENT
Cette section est expliquée plus en détail dans la partie « Unité Element » (page 21).

9 Sections [INSERTION EFFECT] (Effet d'insertion)
Cette section est expliquée plus en détail dans la partie « Effet d'insertion » (page 26).

) Réglages SYSTEM EFFECT (Effet système)
Cette section est expliquée plus en détail dans la partie « Effets système » (page 26).

! Clavier
Cliquez sur n'importe quelle touche du clavier pour contrôler la voix éditée à l'aide de cette 
touche.

@ Réglages KEY ASSIGN (Affectation de touche)
Cliquez sur la zone de texte de gauche pour sélectionner un réglage Key Assign. Cliquez sur la 
zone texte de droite pour sélectionner Monophonic ou Polyphonic. Les réglages « KEY 
ASSIGN » ne sont pas disponibles pour les voix de batterie.

# Réglages MICRO TUNE (Accord micro)
Cliquez sur la zone de texte pour sélectionner un réglage d'accordage de micro préprogrammé.
Les réglages « MICRO TUNE » ne sont pas disponibles pour les voix de batterie.
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$ Réglages ASSIGNABLE 1/2
Utilisez ces boutons pour régler la valeur du paramètre affecté à chacun des contrôleurs 1/2.

% Réglages MEQ GAIN CONTROL (Commande de gain de l'égaliseur principal)
Utilisez ces boutons pour régler le gain de chaque bande de fréquence de l'égaliseur à 
quatre bandes.

Section ELEMENT

1 Boutons EL (Elément) 1 à 4
Cliquez sur ces boutons pour ouvrir les boîtes de dialogue « ELEMENT » correspondantes.

n Pour les voix de batterie, le panneau suivant s'affiche. Cliquez sur [KEY C0...C6] pour ouvrir la boîte de 
dialogue « Drum Key » (Touche de batterie) (page 24).

n Pour les voix plug-in, le panneau suivant s'affiche. Cliquez sur [DETAIL] pour ouvrir la boîte de dialogue 
« Plug-in Voice Detail » (Détail de la voix plug-in).

1 VOICE BANK (Banque de voix) ....... Détermine la banque de voix plug-in. 
2 VOICE NUMBER (Numéro de voix).. Détermine le numéro de la voix plug-in. 
3 LFO (OBF) ......................................... Détermine la vitesse de l'OBF, la modulation de hauteur de 

ton et le retard. 
4 NOTE SHIFT (Décalage de notes) ... Détermine l'importance du décalage des notes (transposition 

des touches).

Cliquez sur [NATIVE PARAM] (Paramètre natif) pour ouvrir la boîte de dialogue « NATIVE Parameter ». 
Sélectionnez la carte plug-in à éditer dans le coin supérieur gauche de l'illustration du clavier qui 
apparaît dans la fenêtre. 

21 3 4
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2 Sélecteurs ON/OFF
Cliquez sur ces sélecteurs pour activer/désactiver chaque élément.

3 Boutons de niveau des éléments
Utilisez ces boutons pour régler le niveau de chaque élément.

4 Sélecteurs EF (Effet) 1/EF (Effet) 2/ THRU
Cliquez sur ces sélecteurs pour assigner chaque élément à l'effet d'insertion 1 ou 2 ou pour 
passer outre des sections d'effets d'insertion.

● Boîte de dialogue ELEMENT

1 LFO WAVE (Onde d'OBF)
Cliquez sur la zone de texte « WAVE » et sélectionnez la forme d'onde de l'OBF.

2 LFO SPEED (Vitesse de l'OBF)
Cliquez sur la zone de texte « SPEED » pour spécifier la vitesse.

3 KEY SYNC (Synchronisation des touches)
Cliquez sur « KEY SYNC » pour activer/désactiver la synchronisation des touches de l'OBF. 
(Si ce paramètre est activé, la forme d'onde de l'OBF est relancée à chaque note jouée).

4 KEY ON DELAY (Retard de l'activation de touche)
Détermine le temps (retard) entre le moment où vous appuyez sur une note du clavier et celui 
où l'OBF entre en jeu.
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5 Bouton LFO PITCH (Hauteur de ton de l'OBF)
Ce bouton vous permet de régler la profondeur de modulation de ton de l'OBF. Vous pouvez 
également saisir une valeur directement dans la zone de texte située à gauche du bouton.

6 Bouton LFO FILTER (Filtre de l'OBF)
Ce bouton vous permet de régler la profondeur de modulation du filtre de l'OBF. Vous pouvez 
également saisir une valeur directement dans la zone de texte située à gauche du bouton.

7 Bouton LFO AMPLITUDE (Amplitude de l'OBF)
Ce bouton vous permet de régler la profondeur de modulation de l'amplitude de l'OBF. Vous 
pouvez également saisir une valeur directement dans la zone de texte située à gauche du 
bouton.

8 Bouton [DETAIL]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « EL DETAIL » (Détail des éléments) et 
saisir les paramètres pour chaque élément. Le contrôle des paramètres est plus grand et plus 
précis qu'avec les graphiques de l'éditeur.

Graphiques de l'éditeur
En cliquant sur les « poignées » (repères carrés) de ces graphiques et en les faisant glisser, 
vous pouvez ajuster visuellement les paramètres de chacun des éléments.

n Il arrive que les poignées ne soient pas toutes visibles parce qu'elles sont superposées au même endroit. 
Si c'est le cas, cliquez sur la poignée visible et faites-la glisser temporairement afin de voir la poignée 
suivante.

Réglages OSCILLATOR (Oscillateur)
Cliquez sur la zone de texte « WAVE » et sélectionnez la forme d'onde source. L'un des repères 
carrés sert à régler les paramètres « VEL LIMIT LOW » (Limite de vélocité inférieure) et « NOTE 
LIMIT LOW » (Limite de note inférieure). Réglez la vitesse de la note la plus basse en déplaçant 
la poignée horizontalement. Réglez la note la plus basse de la gamme en la déplaçant 
verticalement. De la même façon, réglez la vélocité de la note la plus haute (« VEL LIMIT HIGH ») 
et la note la plus haute de la plage (« NOTE LIMIT HIGH ») à l'aide de l'autre poignée.

n Lorsque vous déplacez les poignées, des valeurs sont affectées sous la forme de coordonnées (X,Y), où X 
correspond à NOTE LIMIT (Limite de note) (donnée sous la forme d'un numéro de note MIDI) et Y à VEL 
LIMIT (Limite de vélocité). Pour afficher le nom de la note au lieu de son numéro, sélectionnez l'onglet 
« OSCILLATOR » de la boîte de dialogue « EL DETAIL ».
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Réglages FILTER (Filtre)
Cliquez sur la zone de texte et sélectionnez le type de filtre. Le graphique affiche des réglages 
préprogrammés, mais vous pouvez les modifier. Si vous prenez le type LPF à titre d'exemple, 
déplacez la poignée gauche verticalement pour régler le paramètre « Filter Gain » (Gain de filtre). 
Faites glisser la poignée droite horizontalement pour régler la fréquence de coupure du filtre.

n Les valeurs des paramètres s'affichent au fur et à mesure que vous déplacez les poignées. Pour régler ces 
valeurs directement, sélectionnez l'onglet « FILTER EG » de la boîte de dialogue « EL DETAIL ».

Réglages EQ
Cliquez sur la zone de texte et sélectionnez le type d'égaliseur. Par exemple, si vous prenez le type 
EQ/LH, la poignée de gauche permet de contrôler les fréquences des basses et la poignée de 
droite les fréquences des aiguës. Déplacez les poignées verticalement pour régler le gain et 
horizontalement pour ajuster la fréquence.

n Pour régler ces valeurs directement, sélectionnez l'onglet « OSCILLATOR » de la boîte de dialogue « EL 
DETAIL ».

Réglages PITCH EG (Générateur d'enveloppe de hauteur)
Le PITCH EG (Envelope Generator) détermine la transition de la hauteur de ton lorsque la touche 
est maintenue enfoncée. Il y a cinq poignées, chacune contrôlant un stade différent de 
l'enveloppe. La première poignée (la plus à gauche) contrôle le paramètre « Hold Time/Level » 
(Temps/niveau de maintien), la deuxième le paramètre « Attack Time/Level » (Temps/niveau 
d'attaque), la troisième le paramètre « Decay 1 Time/Level » (Temps/niveau de chute 1), la 
quatrième le paramètre « Decay 2 Time/Sustain Level » (Temps de chute 2/niveau de maintien) et 
la dernière (la plus à droite) le paramètre « Release Time/Level » (Temps/niveau de relâchement). 
Déplacez les poignées verticalement pour ajuster les niveaux et horizontalement pour régler les 
temps de transition.

n Pour régler ces valeurs directement, sélectionnez l'onglet « PITCH » de la boîte de dialogue « EL DETAIL ».

Réglages FILTER EG (Générateur d'enveloppe de filtre)
Le paramètre FILTER EG détermine la transition du timbre lorsque la touche est maintenue 
enfoncée. Il y a cinq poignées, chacune contrôlant un stade différent de l'enveloppe. La première 
poignée (la plus à gauche) contrôle le paramètre « Hold Time/Level », la deuxième le paramètre 
« Attack Time/Level », la troisième le paramètre « Decay 1 Time/Level », la quatrième le paramètre 
« Decay 2 Time/Sustain Level » et la dernière (la plus à droite) le paramètre « Release Time/
Level ». Déplacez les poignées verticalement pour ajuster les niveaux et horizontalement pour 
régler les temps de transition.

n Pour régler ces valeurs directement, sélectionnez l'onglet « FILTER EG » de la boîte de dialogue « EL 
DETAIL ».

Réglages AMPLITUDE EG (Générateur d'enveloppe d'amplitude)
L'AMPLITUDE EG détermine la transition de l'amplitude dans le temps. Il y a cinq poignées, 
chacune contrôlant un stade différent de l'enveloppe. La première poignée (à l'extrême gauche) 
contrôle le paramètre « Init Level » (Niveau initial), la deuxième le paramètre « EG Attack Time » 
(Temps d'attaque de l'EG), la troisième le paramètre « EG Decay 1 Time/Level » (Temps/niveau de 
chute 1 de l'EG), la quatrième le paramètre « Decay 2 Time/Sustain Level » et la dernière (la plus à 
droite) le paramètre « EG Release Time » (Temps de relâchement de l'EG). Déplacez les poignées 
verticalement pour ajuster les niveaux et horizontalement pour régler les temps de transition.

n Pour régler ces valeurs directement, sélectionnez l'onglet « AMP EG » de la boîte de dialogue « EL 
DETAIL ».
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Boîte de dialogue « DRUM KEY »

1 Note...................................Affiche le nom de la note à éditer. 
2 Clavier...............................Cliquez sur le clavier pour affecter une note à l'élément ou à la 

voix en cours d'édition. La zone de texte à gauche affiche le 
nom de la note.

3 TYPE .................................Détermine la banque à laquelle appartient la source sonore : 
Preset Wave (Onde préprogrammée) ou Voice (Voix).

4 WAVE.................................Pour sélectionner une forme d'onde comme source, cliquez 
sur ce bouton, puis dans la zone de texte adjacente où vous 
pouvez la choisir.

5 VOICE ................................Pour sélectionner une voix comme source, cliquez d'abord sur 
ce bouton, puis dans la zone de texte adjacente pour ouvrir la 
boîte de dialogue « Voice List » (Liste de voix).

6 COARSE (Brut).................Utilisez ce bouton pour régler la hauteur de ton de l'élément 
par demi-tons.

7 VELOCITY .........................Utilisez ce bouton pour définir la variation du ton en fonction de 
la vitesse de la note.

8 FINE (Fin)..........................Utilisez ce bouton pour la régler avec encore plus de 
précision.

9 CUTOFF (Coupure) ..........Utilisez ce bouton pour régler la fréquence de coupure du filtre 
passe-bas.

) VELOCITY .........................Utilisez ce bouton pour régler l'ouverture et la fermeture du 
filtre de l'élément par rapport à la vitesse de la note.

! RESO (Résonance)..........Utilisez ce bouton pour régler le niveau de résonance du filtre 
passe-bas.

@ HPF (Filtre passe-haut) ...Utilisez ce bouton pour régler la fréquence du filtre passe-haut.
# AMPLITUDE VELOCITY ...Utilisez ce bouton pour définir la variation du niveau de sortie 

(Vélocité de l'amplitude) de l'élément en fonction de la vélocité de la note.
$ RECEIVE NOTE ................Cliquez sur la zone de texte pour choisir de recevoir ou non 

(Réception de notes) des notes.
% KEY ASSIGN ....................Cliquez sur la zone de texte pour choisir entre l'affectation 

(Affectation de touches) d'une touche unique ou de plusieurs touches.
^ ALTERNATE GROUP .......Cliquez sur la zone de texte pour sélectionner un autre numéro 

(Groupe alternatif) de groupe. Vous pouvez ainsi empêcher des sons de batterie 
couplés de se produire en même temps (par exemple, une 
cymbale ouverte et fermée).
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& FILTER ..............................Faites glisser une des poignées horizontalement pour régler le 
paramètre « HPF Cutoff Frequency » (Fréquence de coupure 
du filtre passe-haut) de l'élément. Faites glisser l'autre poignée 
verticalement pour régler le paramètre « LPF Resonance » 
(Résonance du filtre passe-bas) et horizontalement pour régler 
le paramètre « LPF Cutoff Frequency » (Fréquence de coupure 
du filtre passe-bas).

n Pour régler ces valeurs directement, sélectionnez l'onglet « OSCILLATOR » de la boîte de dialogue 
DRUM KEY DETAIL (Détail des touches de batterie).

* AMPLITUDE EG ...............Faites glisser la première poignée (la plus à gauche) 
horizontalement pour ajuster le paramètre « Attack Time » de 
l'élément. Faites glisser la deuxième horizontalement pour 
régler le paramètre « Decay 1 Time » et verticalement pour 
régler son niveau de déclin « Decay 1 Level ». Faites glisser la 
dernière (la plus à droite) horizontalement pour ajuster le 
paramètre « Decay 2 Time ». 

n Pour régler ces valeurs directement, sélectionnez l'onglet « PARAMETER » de la boîte de dialogue 
DRUM KEY DETAIL.

( EQ .....................................Cliquez sur la zone de texte pour sélectionner le type d'EQ. 
Avec les types « EQ L/H » et « P.EQ », vous pouvez ajuster 
certains paramètres EQ à l'aide des poignées présentes dans 
les graphiques. Déplacez l'une des poignées horizontalement 
pour régler le paramètre « EQ Low Frequency » (Fréquence 
des basses de l'égaliseur) de l'élément et verticalement pour 
ajuster le paramètre « EQ Low Gain » (Gain des basses 
fréquences de l'égaliseur). Faites glisser l'autre poignée 
horizontalement pour ajuster le paramètre « EQ High 
Frequency » (Fréquence des aiguës de l'égalisateur) de 
l'élément (ou « EQ Resonance » si vous avez sélectionné le 
type P.EQ) et verticalement pour ajuster le paramètre « EQ 
High Gain » (Gain des hautes fréquences de l'égaliseur).

n Pour régler ces valeurs directement, sélectionnez l'onglet « OSCILLATOR » de la boîte de dialogue 
DRUM KEY DETAIL.

º LEVEL ...............................Ce bouton vous permet de régler le niveau de l'élément.
¡ PAN ...................................Ce bouton vous permet de régler la position stéréo de 

l'élément.
™ RNDM PAN........................Utilisez ce bouton pour régler la profondeur du balayage

(Balayage aléatoire) aléatoire « Random Pan » de l'élément.
£ ALTER PAN.......................Utilisez ce bouton pour régler la profondeur du balayage 

(Balayage alternatif) alternatif « Alternate Pan ».
¢ Sélecteur de l'affectation .Cliquez sur la zone de texte pour sélectionner les sorties vers 

de la sortie lesquelles vous voulez envoyer l'élément. 
∞ EF1/EF2/THRU .................Cliquez sur le sélecteur [EF 1] pour transférer le signal via 

l'effet d'insertion 1, sur [EF 2] pour le transmettre via l'effet 
d'insertion 2 et sur [THRU] pour ignorer les effets d'insertion.

§ REVERB (Réverbération)..Utilisez ce bouton pour régler le niveau du signal des effets 
d'insertion 1/2 (ou le signal ignoré) envoyé à l'unité de 
réverbération.

¶ CHORUS (Chœur) ............Utilisez ce bouton pour régler le niveau du signal des effets 
d'insertion 1/2 (ou le signal ignoré) envoyé à l'unité de 
réverbération.

• DETAIL ..............................Cliquez sur ce bouton pour ouvrir la boîte de dialogue « DRUM 
KEY DETAIL » et saisir directement des valeurs pour tous les 
éléments (à l'exception de l'affectation des notes du clavier).

n Le signal émis par l'EQ est envoyé vers le paramètre LEVEL situé dans le coin inférieur gauche de 
la boîte de dialogue Drum Key. 

n Lorsque le paramètre OSCILLATOR TYPE est réglé sur « Voice », les paramètres 7, 9 -14, 16 -19, 
22 et 23 décrits ci-dessus ne sont pas disponibles.
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Section Insertion Effect 1

1 Sélecteur CONNECT (Connexion)
Cliquez sur la zone de texte et sélectionnez l'ordre dans lequel les signaux sont transmis 
d'une section d'effet d'insertion à l'autre.

2 Témoins lumineux
Ces témoins vous indiquent quels éléments sont affectés aux différentes sections d'effets 
d'insertion. Ils ne sont pas disponibles pour les voix de batterie.

3 Bouton [DETAIL]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue Insertion Effect et régler les paramètres 
détaillés. 

4 Sélecteur du type d'effet
Cliquez sur la zone de texte et sélectionnez le type d'effet d'insertion.

Section Insertion Effect 2
Identique à la section Insertion Effect 1. Voir ci-dessus. 

Effets système

● Section Reverb

1 Reverb Send (Envoi de réverbération)
Ce bouton vous permet de régler le niveau du signal de l'effet d'insertion 1/2 (ou du signal 
ignoré) envoyé à l'effet de réverbération.

2 Sélecteur du type d'effet de réverbération
Cliquez sur la zone de texte et sélectionnez le type d'effet de réverbération. 

1

3

4

2
4
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3 Commandes Reverb Pan (Panoramique de réverbération)
Utilisez ces boutons pour régler la position stéréo de l'effet de réverbération.

4 Commandes Reverb Return (Retour de réverbération)
Ces boutons vous permettent de régler le volume de chacun des effets de réverbération 
utilisés dans le signal de sortie.

5 Bouton [DETAIL]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue Reverb et régler les paramètres 
détaillés. 

● Section Chorus

1 Chorus Send (Envoi vers le chœur)
Ce bouton vous permet de régler le niveau du signal de l'effet d'insertion 1/2 (ou du signal 
ignoré) envoyé à l'effet de chœur.

2 Sélecteur du type d'effet de chœur
Cliquez sur la zone de texte et sélectionnez le type d'effet de chœur. 

3 Commande Chorus Pan (Panoramique de chœur)
Utilisez ce bouton pour régler la position stéréo de l'effet de chœur.

4 Commande Chorus Return (Retour de chœur)
Utilisez ce bouton pour régler le volume de chaque effet de chœur utilisé dans le signal de 
sortie.

5 Bouton [DETAIL]
Cliquez sur ce bouton pour ouvrir la boîte de dialogue Chorus et régler les paramètres 
détaillés. 

6 Commande CHORUS REVERB (Chœur vers réverbération)
Ce bouton vous permet de régler le niveau du signal envoyé depuis l'effet de chœur vers 
l'effet de réverbération.

2

1

65 3 4
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Barre d'outils

1 Bouton « Editor Setup »
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Editor Setup ». Voir page 11 pour 
plus de détails. 

2 Bouton « Library Window » (Fenêtre Library)
Cliquez sur ce bouton pour faire réapparaître la fenêtre Library au premier plan. Voir page 16 
pour plus de détails. 

3 Bouton « Store »
Cliquez sur ce bouton pour ouvrir la boîte de dialogue « Store ». Voir ci-dessous pour plus de 
détails. 

Boîte de dialogue « Store »
Vous pouvez stocker la voix éditée dans n'importe quel fichier Bibliothèque. 

1 Cliquez sur la case Voice Name (Nom de voix) en haut de la boîte de dialogue. Le curseur 
apparaît en surbrillance et vous pouvez alors saisir les caractères du nom.

2 Saisissez le nom de la voix via le clavier de l'ordinateur. 

n Les noms de voix peuvent comporter jusqu'à 10 caractères.

3 Cliquez sur la case Memory et choisissez la mémoire dans laquelle vous souhaitez 
stocker la voix éditée.

1 2 3 4
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4 Dans la liste Voice Name, cliquez sur la voix dans laquelle vous voulez stocker la voix 
éditée.

Une fois stockées dans un fichier Bibliothèque, les données de la voix d'origine sont écrasées lorsque vous 
sauvegardez ce fichier. Il est dès lors recommandé d'effectuer des copies de sauvegarde de toutes les 
données importantes.

5 Cliquez sur le bouton [Store] pour stocker la voix éditée à l'emplacement spécifié dans 
l'étape 4.

La boîte de dialogue « Store » est utilisée pour stocker temporairement votre fichier Bibliothèque. Après 
l'avoir stocké, vous devez l'enregistrer. Si vous ne le faites pas, les modifications apportées au fichier ne 
seront pas sauvegardées.

4 Bouton « Compare »
Lorsque vous cliquez sur ce bouton, des blocs de données de la voix d'origine (avant édition) 
sont envoyés au synthétiseur. Cliquez de nouveau dessus pour envoyer les blocs de données 
de la voix éditée. Ce bouton permet alors d'effectuer des comparaisons A/B entre la voix 
d'origine et la voix éditée.

Exemple d'utilisation du
Voice Editor
Il n'existe pas une façon unique d'utiliser les nombreux composants du Voice Editor. Vos besoins 
et préférences en matière d'édition peuvent différer. L'exemple suivant est toutefois un guide 
pas-à-pas simple sur la manière d'utiliser le Voice Editor.
La fenêtre Library étant la première à s'ouvrir, c'est là que commencent les explications.

n Dans la fenêtre Library, vous pouvez ouvrir des fichiers Bibliothèque existants contenant les voix que vous 
souhaitez éditer, de même que vous pouvez importer des voix spécifiques vers la fenêtre Library.

1 Cliquez sur le bouton « Editor Setup » de la barre d'outils de la fenêtre Library pour ouvrir la 
boîte de dialogue « Editor Setup ». Sélectionnez ensuite les paramètres MIDI Out Port et 
Device No. adaptés à votre synthétiseur (reportez-vous à la section Boîte de dialogue « Editor 
Setup »).

n Si vous utilisez un Macintosh, vous devez également régler les paramètres de l'OMS (page 31).

n Si vous utilisez Windows, vous devez également effectuer des réglages dans la barre d'outils MIDI 
Setup ou dans le port MIDI de l'application hôte.

2 Recevez les données de voix utilisateur en provenance de votre synthétiseur.

1 Sélectionnez [Receive Bulk...(Receive...)] (Recevoir en bloc... (Recevoir...)) (page 6) dans 
le menu [Setup (MIDI)].

ATTENTION

ATTENTION
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2 Sélectionnez « All » (Tous) dans « Receive Type » (Type de réception), puis cliquez sur le 
bouton [Start] (page 13). Fermez la boîte de dialogue après réception. La voix reçue 
apparaît alors.

3 Dans la liste de voix de la fenêtre Library, double-cliquez sur la voix que vous souhaitez 
modifier. La fenêtre Edit correspondant à cette voix s'ouvre.

4 Plusieurs blocs sont arrangés dans la fenêtre Edit. Commencez par régler les paramètres des 
éléments 1 à 4 du bloc Element qui constituent la voix. Ouvrez les boîtes de dialogue des 
éléments 1 à 4, sélectionnez les formes d'onde et ajustez les caractéristiques sonores de la 
voix à l'aide des filtres et des égaliseurs. Vous pouvez utiliser les éditeurs graphiques 
présents dans les différentes boîtes de dialogue pour modifier visuellement les paramètres.

n Vous pouvez modifier les paramètres des éléments avec beaucoup plus de précision dans les boîtes de 
dialogue « EL DETAIL ». Les boîtes de dialogue des éléments sont associées aux boîtes de dialogue 
« EL DETAIL », de sorte que toutes les modifications apportées dans les unes sont immédiatement 
répercutées dans les autres. Vous pouvez voir simultanément les graphiques et les boîtes de dialogue 
« EL DETAIL » côte à côte pendant l'édition.

n De plus, dans la section Element, vous pouvez régler le niveau de sortie de chaque élément et les 
associer aux effets d'insertion 1/2.

5 Utilisez [Quick Edit] pour ajuster tous les niveaux et les caractéristiques sonores des voix.

n En cliquant et déplaçant les boutons du clavier situé en bas de la fenêtre, vous pouvez contrôler la 
voix que vous éditez.

n Si vous activez le bouton « Compare » de la barre d'outils, vous pouvez effectuer des comparaisons A/
B entre la voix originale et la voix éditée.

6 Sélectionnez le type d'effet d'insertion dans l'unité d'insertion 1/2 et réglez les paramètres 
restants.

7 Sélectionnez le type d'effet système dans la section Reverb/Chorus et réglez les paramètres 
restants.

8 Si nécessaire, réglez les paramètres Arpeggio et Portamento.

9 Cliquez sur le bouton « Store » (Stocker) de la barre d'outils de la fenêtre Edit pour ouvrir la 
boîte de dialogue « Store », qui vous permet de stocker les modifications de la voix 
actuellement sélectionnée dans le fichier Bibliothèque.

n Les modifications apportées à la voix ne sont enregistrées dans le fichier Bibliothèque que de façon 
temporaire. N'oubliez pas que si vous poursuivez sans enregistrer le fichier Bibliothèque, vous perdrez 
toutes les modifications apportées.

10 Revenez dans la fenêtre Library et cliquez sur le bouton « Save » de la barre d'outils pour 
enregistrer (écraser) le fichier Bibliothèque. Les modifications apportées à la voix, ainsi que 
la voix elle-même, sont enregistrées à l'endroit indiqué de la liste de voix.

n Vous pouvez ouvrir le fichier Bibliothèque que vous avez enregistré dans la fenêtre Library à tout 
moment. En outre, vous pouvez envoyer les voix de la fenêtre Library à votre synthétiseur.

n Vous pouvez créer de nombreux fichiers Bibliothèque différents, taillés sur mesure pour des 
applications différentes, telles que des performances live, des enregistrements, etc. Vous pouvez 
donc modifier les voix à votre guise de manière à ce qu'elles répondent à différents besoins ou 
situations.
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Réglages OMS (Macintosh)
Le logiciel Voice Editor utilise l'OMS (Open Music System (Système de musique ouvert)) pour les 
entrées/sorties MIDI. Pour utiliser le logiciel Voice Editor, vous devez préalablement installer 
l'OMS.

n  Pour plus d'informations sur l'installation de l'OMS, reportez-vous au manuel d'installation fourni à part.

A propos de l'OMS
Le Voice Editor utilise l'OMS (Open Music System) pour transférer des données MIDI vers un 
périphérique MIDI externe. OMS est une extension système localisée dans le dossier Mac OS 
System et qui est conçue pour gérer le flux de données MIDI (entrée et sortie) dans un ordinateur 
de manière à permettre le transfert de données MIDI entre le logiciel et le matériel MIDI relié à 
l'ordinateur. OMS est un standard de facto dans l'environnement MIDI sous Mac OS. De 
nombreux fabricants de logiciels de musique ont mis sur le marché un séquenceur et d'autres 
logiciels compatibles avec OMS.
OMS présente les avantages suivants :

• Etant donné que les applications MIDI compatibles OMS communiquent avec divers 
appareils MIDI via l'OMS, il n'est plus nécessaire d'installer différents pilotes MIDI pour ces 
applications. Par conséquent, vous pouvez éviter des conflits entre différents pilotes ayant le 
même rôle (contrôle MIDI).

• Une fois que la configuration de studio est lue dans l'OMS, l'application compatible OMS la 
détecte, même si vous devez reconfigurer le routage du flux de données MIDI ou modifier la 
configuration de studio en cours. Les applications compatibles avec l'OMS reconnaissent 
généralement la nouvelle configuration.

• Vous avez le choix entre différentes configurations de studio, qui vous permettent de basculer 
instantanément vers un routage MIDI différent (connexions entre les périphériques et le 
logiciel MIDI). 

• Chaque fois que vous ouvrez l'application de configuration OMS, tous les appareils MIDI 
connectés à l'ordinateur sont automatiquement détectés. Une icône apparaît alors avec un 
état MIDI actuel (numéro de canal, numéro de port, connexions, etc.). Une fois que les 
périphériques sont correctement configurés à l'aide de l'application OMS Setup, vous ne 
devez plus vous préoccuper du statut.

• L'OMS peut piloter plusieurs interfaces MIDI, y compris le type standard (16 canaux) et le 
type multi-port (16 canaux par port). Si vous utilisez un type multi-port, vous pouvez contrôler 
plus de 16 pistes simultanément via l'OMS.

n Pour plus d'informations sur les caractéristiques OMS, reportez-vous au fichier READ ME (Lisez-moi) 
fourni avec l'OMS. Configuration de l'OMS

Configuration de l'OMS
Les fichiers de configuration du S90 ayant été conçus pour être utilisés avec le Voice Editor, il 
vous faut utiliser le fichier adapté à votre appareil. 

1 Connectez un câble USB dans les ports appropriés du S90 et du Macintosh, puis réglez le 
paramètre « MIDI IN/OUT » (UTILITY [F5] → [SF4]) du S90 sur « USB ». 

2 Double-cliquez sur l'icône « OMS Setup » du dossier « OMS Application ».

3 Dans le menu File, choisissez « Open » et sélectionnez « S90-USB » dans le dossier « OMS 
setup for YAMAHA » (Configuration OMS pour Yamaha). 
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4 Choisissez « Make Current » (Activer) dans le menu File. La configuration de votre S90 est 
maintenant sauvegardée en tant que configuration de studio actuelle.

5 Dans le menu File, choisissez « Quit » pour mettre fin à la configuration OMS.

n Le Voice Editor n'est pas compatible avec les versions OMS antérieures à la version 2.0.

Configuration des ports OMS
Une fois que vous avez configuré l'OMS, vous devez lancer le Voice Editor et paramétrer les 
ports OMS.

1 Lancez le Voice Editor en double-cliquant sur son icône.

n Si AppleTalk est activé, un message d'avertissement apparaît. Cliquez sur « OFF » (Désactiver). La 
désactivation d'AppleTalk prend un certain temps.

2 Sélectionnez « OMS Port Setup » dans le menu « MIDI » du Voice Editor, puis sélectionnez 
les réglages des ports.
Dans l'exemple suivant, le générateur de sons est un S90 et ses paramètres s'appliquent à 
l'OMS.

Key Thru .................Cochez cette case si vous contrôlez un module de générateur de sons à 
l'aide d'un clavier externe.

MIDI In: ..................Sélectionnez « S90-1 ».
MIDI Out: ...............Sélectionnez « S90-1 ».

3 Cliquez sur [OK] pour fermer la boîte de dialogue OMS Port Setup.
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Dépistage des pannes
Si vous rencontrez des problèmes tels que l'absence de son ou un comportement anormal, 
vérifiez les connexions avant de passer aux points suivants. 

<Windows / Macintosh>
Le son ne change pas lorsque vous manipulez les boutons ou les curseurs.

• Le port de sortie MIDI et le numéro de l'appareil sont-ils correctement paramétrés dans la 
boîte de dialogue « Editor Setup » ? (pages 11, 32)

Les blocs de données ne sont pas transmis.
• Le port de sortie MIDI et le numéro de l'appareil sont-ils correctement paramétrés dans la 

boîte de dialogue « Editor Setup » ? (pages 11, 32)
• L'intervalle de vidage défini dans la boîte de dialogue « Editor Setup » n'est-il pas trop 

court ? Assurez-vous que l'intervalle est d'au moins 20 ms.

Le son est dédoublé lorsque vous jouez du clavier.
• Positionnez le sélecteur Local de votre synthétiseur sur OFF.

Aucun son ne sort lorsque vous cliquez sur le clavier qui apparaît à l'écran dans la fenêtre 
Edit.

• Le canal MIDI est-il correctement paramétré dans la boîte de dialogue « Editor Setup » ? 
(page 11)

Le son ne change pas lorsque vous appuyez sur le bouton Monitor.
• Le port MIDI Out et le numéro de l'appareil sont-ils correctement réglés dans la boîte de 

dialogue Editor Setup (OMS Port Setup) ? (pages 11, 32)

Les fichiers Bibliothèque créés dans le Voice Editor ne peuvent pas être lus directement 
par le S90.

• Donnez au fichier l'extension « W2E » de manière à pouvoir lire les fichiers Bibliothèque du 
Voice Editor directement sur votre synthétiseur. Le fichier correspondant (extension 
« W5E ») doit être copié au même endroit (dossier) que « W4E ». 

<Windows>
Les bloc de données ne sont pas reçus.

• Ouvrez la boîte de dialogue « Editor Setup » et vérifiez que le numéro de l'appareil est 
correctement affecté (page 11). 

Le port MIDI In/Out n'est pas disponible dans la boîte de dialogue Editor Setup.
• Le port MIDI In/Out de la boîte de dialogue Editor Setup est sélectionné à partir des ports 

MIDI In/Out de la boîte de dialogue MIDI Setup. Vérifiez les réglages MIDI In/Out de la 
barre d'outils MIDI Setup ou de l'application hôte.

<Macintosh>
Le port USB n'est pas reconnu.

• Vérifiez si le pilote USB a été correctement installé sur votre ordinateur. Reportez-vous au 
manuel d'installation pour plus de détails. 
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Le port du modem/de l'imprimante n'est pas reconnu.
• Vérifiez la connexion et les réglages de l'interface MIDI. 
• Sur certains modèles Macintosh comme ceux de la série Performa, il est impossible 

d'utiliser le port du modem. Seul le port de l'imprimante est disponible.
• Le port du modem/de l'imprimante n'est pas reconnu lorsque AppleTalk est activé. Veuillez 

noter que sur certains modèles Macintosh, AppleTalk est automatiquement activé au 
démarrage.

• Vérifiez que la case « Modem » ou « Printer » (Imprimante) a bien été cochée dans la 
fenêtre OMS MIDI Setup.

Pas de données MIDI In/Out
• Vérifiez si le réglage MIDI IN/OUT du mode Utility (Utilitaire) correspond au câble utilisé 

(USB ou MIDI). 
• Les ports MIDI In/Out sont-ils configurés comme étant inconnus dans la fenêtre OMS Port 

Setup ? Si vous modifiez les ports ou les paramètres de l'OMS, les ports de sortie de 
l'OMS doivent être configurés en conséquence dans la fenêtre OMS Port Setup du Voice 
Editor. Sélectionnez l'appareil de réception approprié.

• Si l'affectation des ports et des paramètres est fréquemment modifiée, il est possible que 
l'OMS éprouve des difficultés à reconnaître le port. Redémarrez le Macintosh, configurez 
l'OMS correctement, puis lancez le Voice Editor.

Les bloc de données ne sont pas reçus.
• Ouvrez la fenêtre OMS Port Setup et vérifiez que le port MIDI In a été correctement 

configuré (page 32).
• Ouvrez la boîte de dialogue Editor Setup et vérifiez que le numéro de l'appareil est 

correctement affecté (page 11). 

Le Voice Editor ne démarre pas lorsque vous double-cliquez sur le fichier Bibliothèque 
(extension .W4E).

• Modifiez les réglages Type/Creator (Créateur) des fichiers Bibliothèque comme suit, puis 
essayez de nouveau de double-cliquer sur le fichier.
Type : W4E_
Creator : YS90


	Qu'est-ce que le Voice Editor ? 2
	Démarrage du Voice Editor 3
	Barre de menus 4
	Fenêtre Library 7
	Barre d'outils de la fenêtre Library 9

	Fenêtre Edit 15
	Exemple d'utilisation du Voice Editor 29
	Réglages OMS (Macintosh) 31
	Dépistage des pannes 33

